## Version Status:

<table>
<thead>
<tr>
<th>Release Number</th>
<th>Date</th>
<th>Reason for Version</th>
</tr>
</thead>
</table>
| 0.1            | July 2008| First Draft – Jan Bennellick  
Update of current 6.1.4 User Guide – new screen shots, modification where changed functionality and addition of new functionality.  
Revised Locations and Searching sections. |
| 0.2            | April 2009| Revised Record Types                                                               |
# Table of Contents

1. **About this User Guide** .......................................................................................................................... 6

2. **TRIM Overview** ..................................................................................................................................... 7
   2.1 Navigating TRIM ...................................................................................................................................... 7
   2.1.1 Monash Toolbar .............................................................................................................................. 7
   2.1.2 Find Records Pane .......................................................................................................................... 7
   2.1.3 Student Records Toolbar .............................................................................................................. 7
   2.1.4 Monash Shortcuts .......................................................................................................................... 8
   2.2 The TRIM Search Results Window ...................................................................................................... 8
   2.3 Modifying the List Pane .................................................................................................................... 10
   2.4 Modifying the View Pane .................................................................................................................. 13
   2.5 User's Default Settings ..................................................................................................................... 14
   2.5.1 Install or re-install TRIM default settings ..................................................................................... 14
   2.5.2 Change default Dropped Files setting .......................................................................................... 15
   2.5.3 Change default Search Filters ...................................................................................................... 16
   2.5.4 Install Student Records Toolbar .................................................................................................. 18

3. **Record Types** ....................................................................................................................................... 19

4. **Understanding Locations** .................................................................................................................. 22
   4.1 Internal Locations ............................................................................................................................... 23
   4.2 External Locations ............................................................................................................................. 23
   4.3 Locations Maintenance ...................................................................................................................... 23

5. **Searching** ............................................................................................................................................ 24
   5.1 Find Records Functionality ............................................................................................................... 24
   5.1.1 Search Tab ...................................................................................................................................... 24
   5.1.2 Sort Tab ......................................................................................................................................... 26
   5.1.3 Filter Tab ....................................................................................................................................... 27
   5.1.4 Conducting a Simple Search ......................................................................................................... 29
   5.1.5 Using Multiple Search Criteria ..................................................................................................... 29
   5.1.6 Refining a Search ........................................................................................................................... 31
   5.2 TRIM Search Methods ...................................................................................................................... 31
   5.2.1 Word Searches ............................................................................................................................. 32
   5.2.2 Date Searches ............................................................................................................................... 33
   5.2.3 Additional Field Searches ............................................................................................................. 34
   5.2.4 Location Searches .......................................................................................................................... 35
   5.3 Other Search Options ....................................................................................................................... 36
   5.3.1 Using the Find Records Pane ........................................................................................................ 36
   5.3.2 Navigate ....................................................................................................................................... 36
   5.3.3 Favourites ..................................................................................................................................... 37
   5.3.4 Browsing via Classifications ......................................................................................................... 38

6. **Saved Searches** ................................................................................................................................... 39
   6.1 Saving Searches ................................................................................................................................... 39
   6.1.1 Saving a Search ............................................................................................................................. 39
   6.1.2 Accessing a Saved Search ............................................................................................................. 40

7. **Saving and Viewing Electronic Records** .......................................................................................... 41
   7.1 Guidelines for scanning documents to PDF for registration in TRIM ........................................................ 41
   7.2 Saving an Electronic record .............................................................................................................. 41
   7.2.1 General Guidelines for Document Titling ..................................................................................... 42
   7.2.2 Completing the Central Document Registration Screen ................................................................ 43
   7.2.3 Completing the HR Document Registration Screen .................................................................... 45
   7.2.4 Completing the Student Document Registration Screen .............................................................. 46
   7.3 Saving an Email .................................................................................................................................. 47
   7.3.1 Thunderbird ................................................................................................................................... 47
   7.3.2 Lotus Notes .................................................................................................................................... 48
   7.3.3 Saving an Attachment to a Lotus Notes Email ............................................................................. 48
   7.4 Adding a New Contact ....................................................................................................................... 49

---

TRIM eRMS User Guide July 2008

Page 3 of 73
7.4.1 Creating an Organisation Location .......................................................... 49
7.4.2 Creating a Person Location .................................................................. 50
7.4.3 Creating a location for a Monash Staff Member ............................... 52
7.5 Viewing a Record’s Properties ............................................................... 52
7.6 Viewing an Electronic Document ............................................................ 53
7.7 Emailing an Electronic Document ........................................................... 53
7.8 Double-clicking in TRIM ........................................................................ 54

8 Modifying Records .................................................................................. 55
8.1 Changing a Title ..................................................................................... 55
8.2 Changing the File .................................................................................. 55
8.3 Adding a Note ......................................................................................... 56
8.4 Relating Records ................................................................................... 57
8.5 Updating Student Records ...................................................................... 58
8.5.1 Changing the Title of a Student File .................................................. 58
8.5.2 Associating a Student Document with a Central file ......................... 59

9 Security and Access Controls .................................................................... 61
9.1 Access Controls ..................................................................................... 61
9.2 Changing Access Controls ..................................................................... 64
9.2.1 Central Files and Documents ............................................................ 65
9.2.2 HR Files and Documents .................................................................. 65
9.2.3 Legal Folders and Documents .......................................................... 66
9.2.4 Student Files and Documents ............................................................ 66

10 Moving Records ..................................................................................... 68
10.1 Changing the Assignee .......................................................................... 68

11 Printing Reports ....................................................................................... 69
11.1 Print Report ........................................................................................... 69
11.2 Print Merge ........................................................................................... 71
Table of Figures

Figure 1 - TRIM Online Help.......................................................... 6
Figure 2 - Monash Toolbar .......................................................... 7
Figure 3 - Find Records Pane ...................................................... 7
Figure 4 - Student Records Toolbar .......................................... 8
Figure 5 - Monash Shortcuts ...................................................... 8
Figure 6 - TRIM Search Results Window ................................... 9
Figure 7 - Modifying information displayed in the List Pane .......... 11
Figure 8 - Column Preferences dialog box ................................ 11
Figure 9 - Modifying the View Pane ........................................... 13
Figure 10 - Record View Pane Options ..................................... 13
Figure 11 - TRIM Context Options dialog box ......................... 14
Figure 12 - Select from Record Types dialog box ..................... 15
Figure 13 - TRIM Context User Options – Dropped Files dialog box 16
Figure 14 - Set Default Find Filters .......................................... 17
Figure 15 - Student Records Default Toolbar Settings ............... 18
Figure 16 - Determining a Record Type from search results ......... 21
Figure 17 - Location Types – Persons, Organisations and Groups .. 22
Figure 18 - Find Records dialog box ......................................... 24
Figure 19 - Selecting a Search Method by Category ................... 25
Figure 20 - Selecting a Search Method by Description ............... 25
Figure 21 - Selecting a Search Method from the Drop-Down list .... 26
Figure 22 - Search Sort Tab ....................................................... 27
Figure 23 - Search Filter Tab ..................................................... 28
Figure 24 - Filter by Record Types .......................................... 29
Figure 25 - Searching using multiple Search Criteria .................. 30
Figure 26 - Classifications - Function List ................................ 38
Figure 27 - Classifications - Browsing Functions and Activities to find a file 38
Figure 28 - New Saved Search dialog box ................................. 39
Figure 29 - Central Document Registration Screen .................... 43
Figure 30 - HR Document Registration Screen ......................... 45
Figure 31 - Student Document Registration Screen ................. 46
Figure 32 - New Organisation dialog box .................................. 49
Figure 33 - New Person dialog box .......................................... 50
Figure 34 - New Person dialog box .......................................... 51
Figure 35 - Electronic Addresses Tab ....................................... 51
Figure 36 - New E-mail dialog box .......................................... 52
Figure 37 - Send to Mail Recipient screen ............................... 53
Figure 38 - Send to Mail Recipient Metadata Tab ...................... 54
Figure 39 - Set Container ......................................................... 55
Figure 40 - Add Note ............................................................... 56
Figure 41 - Add Notes Settings ................................................ 57
Figure 42 - Relate Records ....................................................... 58
Figure 43 - Select Alternatively Within .................................... 59
Figure 44 - Checking the access settings of a record ................. 61
Figure 45 - Selecting Access Controls to be changed ............... 64
Figure 46 - Adding Access Control Locations ......................... 65
Figure 47 - Set Assignee .......................................................... 68
Figure 48 - Print Report - Apply To dialog box ......................... 69
Figure 49 - Report - Records dialog box .................................. 70
Figure 50 - Send To Merge File - Apply To dialog box ............... 71
Figure 51 - Send To Merge File dialog box .............................. 71
1 About this User Guide

The TRIM eRMS User Guide is for staff who have access to TRIM, the Records Management System for Monash University.

The major functional areas of TRIM explored in this manual include:

- TRIM Overview
- Monash University Record Types
- Understanding Locations
- Searching
- Saving and viewing electronic records
- Modifying records
- Understanding record security
- Moving records
- Printing reports

Further information can be found in the TRIM Online Help or contact Records and Archives Services for assistance.

Figure 1 - TRIM Online Help
2 TRIM Overview

This section will familiarise you with most of the common functional components of TRIM. The items listed in this section will be continually referred to throughout this manual.

2.1 Navigating TRIM

Windows in TRIM are typical of windows in other desktop applications. They provide a familiar look and feel and can be maximized and minimized and include right-click menu options.

2.1.1 Monash Toolbar

A Monash toolbar has been configured to provide easy access to the most commonly performed TRIM functions:

![Monash Toolbar](image)

The Monash Toolbar includes the following:

- New
- Print Report
- Find Records
- Refine Search
- Go Back
- View
- All Parts
- Related Records
- Count
- Notes
- Assignee
- Relate Records To
- New Part
- Security / Access
- Active Audit Events
- Close All

2.1.2 Find Records Pane

TRIM includes a Find Records Pane which is displayed at the top of the screen:

![Find Records Pane](image)

Searches can be executed by filling in the criteria and either pressing the Find button next to the Equal To field or the Enter key on the keyboard.

2.1.3 Student Records Toolbar

A Student Records toolbar has been configured to provide easy access for staff working with student files and documents:
The **Student Records** toolbar includes the following:

- New
- Print Report
- Find Records
- Refine Search
- Go Back
- View
- Related Records
- Count
- Notes
- Assignee
- Relate Records To
- Security / Access
- Active Audit Events
- Close All

### 2.1.4 Monash Shortcuts

TRIM includes a Shortcut Bar where users can hold their commonly accessed records and other items. This bar is activated and displayed on the left side of the TRIM window.

The shortcut bar settings configured to meet Monash requirements are as follows:

![Monash Shortcuts](image)

#### 2.2 The TRIM Search Results Window

In general all TRIM windows have five (5) elements. These are depicted in *Figure 6* and described in detail below:
1. **Title Bar**

The Title Bar indicates the dialog box you have opened. It also displays any filtering that has been applied to refine your search. The Title Bar may also display the number of items returned in your search result. If a count does not automatically appear you can use the Count icon on your toolbar.

2. **List Pane Column Headings**

The List Pane Column Headings show the names of the fields that are being displayed in the List Pane. You can customise your List Pane Columns to display specific fields and then sort the order of the results in these fields by clicking each column’s header (see Section 2.3 for how to modify the List Pane).

3. **List Pane**

The List Pane displays the entries returned by the search that has been performed or the window that has been opened. The information in the List Pane is divided into columns (see List Pane Column Headings). The scroll bar at the bottom of the List Pane enables you to scroll through the columns that are being displayed. The scroll bar on the right hand side of the List Pane enables you to scroll through the entries.

4. **View Pane**

The View Pane displays specific information for the selected item. You can customise the View Pane to see more or less information (see Section

**Figure 6 - TRIM Search Results Window**

[Image of TRIM Search Results Window with annotations for each section: Title Bar, List Pane, View Pane, View Pane Tabs]
2.4 for how to modify the View Pane). The Scroll Bar enables you to see all information in the View Pane.

5. View Pane Tabs

The Properties, Notes, Preview and Previous View Pane Tabs allow you to move between the properties (metadata) of a record or other TRIM object, the contents of the notes field, a preview of the electronic document attached to the record and a preview of the previous revision of the electronic document. **Note** that the revision function is not currently in use at Monash.

2.3 Modifying the List Pane

The following List Pane items can be modified:

- Column size
- Column sort order
- Information (fields) displayed

**Column Sizes**

Place your mouse over a column heading; the mouse pointer will change to a +. Click and drag left or right as required. If you place your mouse over the column break and double-click, TRIM will resize the column to best fit the information.

**Column Sort Order**

If you left-click on a column heading, TRIM will automatically sort the list pane in alphabetic or numeric order according to the column selected. The sort can be in descending or ascending order. Each time you click, TRIM will reverse the order. A small triangle will appear in the Column to indicate the sort order.

<table>
<thead>
<tr>
<th>Sort in ascending order</th>
<th>Sort in descending order</th>
</tr>
</thead>
</table>

**Information (Fields) Displayed**

If you wish to change the order of the columns being displayed, or change the information in the columns being displayed, point your mouse at a List Pane Column Heading, right-click and select Format Columns.
Figure 7 - Modifying information displayed in the List Pane

The following dialog box will appear:

Figure 8 - Column Preferences dialog box

Available Columns
This area lists all the fields available to be displayed within the List Pane. The types of fields will depend on the nature of your search. Ensure that you use the scroll bar to see all available columns.

Displayed Columns
This area shows all the columns that are being displayed in the List Pane in the order they will appear.
Adding an Item
Select the required item in the Available Columns list and click the Add button. Use the Up and Down buttons to change the display order.

Removing an Item
Select the required item in the Displayed Columns list and click the Remove button.

Modifying the Format of the Display
The following options allow you to change the format of the display for each of the Active items. right-click on an item and choose:

Display
You have the choice of displaying the Icon for the field (if one exists), Text (field name) or Icon and Text. If these options are grayed out, then the item does not have an icon to be displayed.

Align
The alignment determines the position of the text within the column. You can select from Left, Centred or Right.

Set Width
Set Width allows you to manually set the size of the column in pixels. Although this option is available it is far easier to modify the size of the columns with the mouse.

Best Fit
Best Fit will enlarge or contract the column width to fit the largest data entry in that column.

Use Ellipsis
The use of ellipsis occurs when text will not fit in the display column. The ellipsis (...) will be placed after the text to indicate that the text cannot be fully displayed within the column size.
2.4 Modifying the View Pane

The View Pane can be modified for individual Record Types. Place your mouse in the View Pane, right-click and select Customise.

The View Pane Options dialog box will appear:

Select one of the options within the Available Fields area and double-click or click the Add button to add the field to the Displayed Fields. The Up and Down buttons change the order in which the fields are displayed in the View.
Pane. To remove an unwanted field from the Displayed Fields list, double-click on it or select it and click the Remove button.

2.5 **User’s Default Settings**

The TRIM configuration delivered to your desktop has been specifically designed for Monash. By altering the view and list pane, toolbar and other options you are changing this default design. Whilst this is usually not a problem, some staff may wish to return to the default set-up.

2.5.1 **Install or re-install TRIM default settings**

1. From the Tools menu, select Options. The following window will appear:

![TRIM Context Options dialog box](image)

*Figure 11 - TRIM Context Options dialog box*

2. Select the Get Global button at the base of the dialog box.

3. You will be prompted to change your settings to the global version. Select Yes and your settings will revert.

![TRIM Context confirmation dialog box](image)
2.5.2 Change default Dropped Files setting

You will be prompted to select a Record Type when you save an electronic document to TRIM. The options provided will vary according to your business area:

![Select From Record Types dialog box](image)

Figure 12 - Select from Record Types dialog box

You can, if you wish, set a default record type to use when capturing electronic documents. This will mean that instead of prompting you to select a record type TRIM will automatically display the relevant registration screen.

**Note:** If you have access to more than one record type when saving documents you should not set a default.

Set a default record type as follows:

1. From your Tools menu, select Options.
2. Choose the Dropped Files tab. The following window will appear:
4. Use the Kwikselect on the Default Record Type field and select the relevant Record Type.

5. Select the OK button to save the setting.

### 2.5.3 Change default Search Filters

By default, TRIM searches across all Record Types. You can, if you wish, change this setting so that only relevant Record Types are searched, as follows:

1. Click the Find Records toolbar icon.
2. Choose the Filter tab.
3. Unselect all Record Types by selecting Untag All from the right-click menu:
4. Scroll through the list and select relevant record types by clicking to the left of the icon.

5. Check the Save as Default Filters box and select the OK button to save the settings:
2.5.4 Install Student Records Toolbar

The Monash toolbar is deployed by default. Staff responsible for student administration will need to change this setting after installing the Monash default settings as follows:

1. From the View menu, select Toolbars > Customise.
2. On the Toolbars tab uncheck Monash Toolbar and check Student Records.
3. With Student Records highlighted check Show Text Labels:

![Customize dialog box](image)

*Figure 15 - Student Records Default Toolbar Settings*

4. Click the Close button to save the changed settings.
## Record Types

Record Types are a way to group like items. A Record Type is visually distinguished by its icon (shape and colour). It also differs by its numbering pattern, its access requirements or the metadata collected against the records it represents.

Record Types exist in a hierarchy, i.e. documents are attached to (contained within) files or folders, which in turn can be contained within boxes.

The following Monash Record Types have been configured:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Record Type</th>
<th>Numbering</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Central Document Icon" /></td>
<td>Central Document</td>
<td>CD08/1</td>
<td>Used for documents across all central administration services.</td>
</tr>
<tr>
<td><img src="image" alt="Central File Icon" /></td>
<td>Central File</td>
<td>CF08/1</td>
<td>Used for files across all central administration services.</td>
</tr>
<tr>
<td><img src="image" alt="Legal Folder Icon" /></td>
<td>Legal Folder</td>
<td>LF08/1</td>
<td>Used to register folders to contain legal documents.</td>
</tr>
<tr>
<td><img src="image" alt="Legal Document Icon" /></td>
<td>Legal Document</td>
<td>LD08/1</td>
<td>Used to register legal documents, including originals and amendments.</td>
</tr>
<tr>
<td><img src="image" alt="HR Document Icon" /></td>
<td>HR Document</td>
<td>HRD08/1</td>
<td>Used to register HR documents by Human Resources.</td>
</tr>
<tr>
<td><img src="image" alt="Staff File Icon" /></td>
<td>Staff File</td>
<td>STAFF08/1</td>
<td>Used to register staff files by Human Resources.</td>
</tr>
<tr>
<td><img src="image" alt="HR Subject File Icon" /></td>
<td>HR Subject File</td>
<td>HR08/1</td>
<td>Used to register mostly advertisement files and other HR subject files by Human Resources.</td>
</tr>
<tr>
<td><img src="image" alt="HR Box Icon" /></td>
<td>HR Box</td>
<td>0261-000001</td>
<td>Used by Human Resources to register boxes containing terminated staff files to be stored off site.</td>
</tr>
<tr>
<td><img src="image" alt="Student File Icon" /></td>
<td>Student File</td>
<td>20734395 (student ID)</td>
<td>Used to register Student Files by Records and Archives Services.</td>
</tr>
<tr>
<td><img src="image" alt="Student Document Icon" /></td>
<td>Student Document</td>
<td>SD08/1</td>
<td>Used by staff responsible for Student Administration to register student documents.</td>
</tr>
<tr>
<td><img src="image" alt="Facilities and Services Folder Icon" /></td>
<td>Facilities and Services Folder</td>
<td>FSF09/1</td>
<td>Used to register files by Facilities and Services Division.</td>
</tr>
<tr>
<td><img src="image" alt="Faculty of Education Document Icon" /></td>
<td>Faculty of Education Document</td>
<td>EDD08/1</td>
<td>Used by the Faculty of Education to register faculty documents.</td>
</tr>
<tr>
<td><img src="image" alt="Faculty of Education Folder Icon" /></td>
<td>Faculty of Education Folder</td>
<td>EDF08/1</td>
<td>Used by the Faculty of Education to register faculty files.</td>
</tr>
<tr>
<td><img src="image" alt="Student Record - Archives Icon" /></td>
<td>Student Record - Archives</td>
<td>SR015974</td>
<td>Digitised records of Chisholm Institute of Technology students whose files were microfilmed between 1980 and 1982. These</td>
</tr>
<tr>
<td>Icon</td>
<td>Record Type</td>
<td>Numbering</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>-------------------</td>
<td>-------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>📊</td>
<td>Student Card –</td>
<td>SD0054511</td>
<td>Digitised copies of summary student record cards for Clayton students enrolled between 1961 and 1977. Later cards and cards of students from amalgamated campuses to be added as opportunity arises.</td>
</tr>
<tr>
<td>📂</td>
<td>Student File –</td>
<td>SF02180</td>
<td>Records of hard copy files held in the Archives including those of selected Clayton students, and those of Chisholm Institute of Technology and State College of Victoria Frankston students, whose enrolment predates the electronic record.</td>
</tr>
<tr>
<td>📁</td>
<td>Archival Document</td>
<td>2006/36-E2</td>
<td>Used by Archives to register electronic records not previously registered in the University’s Records Management System and assessed as having ongoing value.</td>
</tr>
<tr>
<td>🚫</td>
<td>Archival Folder</td>
<td>MON1206/007</td>
<td>Used by Archives to register groups of Archival Documents, transferred at one time, from a single source.</td>
</tr>
<tr>
<td>📂</td>
<td>Archival Series</td>
<td>MON0254</td>
<td>Used by Archives to reflect groups of associated records held within the Archives Repository (may include Archival Documents).</td>
</tr>
<tr>
<td>🏁</td>
<td>Staff Record –</td>
<td>E00236491 (staff ID)</td>
<td>Used by Archives to register electronic copies of staff files which pre-date HR-SAP.</td>
</tr>
<tr>
<td>🚫</td>
<td>Staff File –</td>
<td>00236491 (staff ID)</td>
<td>Used by Archives to register staff files not previously registered in the University’s Records Management System, assessed as having ongoing value.</td>
</tr>
<tr>
<td>🚫</td>
<td>Legacy MUA</td>
<td>UCollect numbers</td>
<td>Direct migration of UCollect Item Types MUA-CHIS, MUA-GIPPS, MUA-PRETM.</td>
</tr>
<tr>
<td>🚫</td>
<td>Legacy GIPP-</td>
<td>UCollect numbers</td>
<td>Direct migration of UCollect Item Type GIPP-AGREE.</td>
</tr>
<tr>
<td>🚫</td>
<td>Legacy RMOR-</td>
<td>UCollect numbers</td>
<td>Direct migration of UCollect Item Type RMOR-LEGAL.</td>
</tr>
<tr>
<td>🚫</td>
<td>Legacy PER-</td>
<td>UCollect numbers</td>
<td>Direct migration of UCollect Item Type PER-FILE.</td>
</tr>
<tr>
<td>🚫</td>
<td>Legacy Document</td>
<td>UCollect numbers</td>
<td>Direct migration of UCollect Item Types RMO-AGENDA, RMO-CORR, RMOR-CORR, RMO-</td>
</tr>
<tr>
<td>Icon</td>
<td>Record Type</td>
<td>Numbering</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
<td>-----------</td>
<td>-------------</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Legacy File</td>
<td>UCollect numbers</td>
<td>Direct migration of UCollect Item Types RMO-FILE, RMOR-FILE, RMO-TFILE, RMOR-TFILE. *RMOT-FILE will receive prefix on number of RMOT.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Box</td>
<td>Box1 Box1/07 (UCollect numbers)</td>
<td>Used to register boxes for physical storage.</td>
</tr>
</tbody>
</table>

Legacy Record Types are used for records migrated from the University’s previous Records Management System, UCollect.

To determine a record type from a TRIM search results screen hover your mouse over the far left icon (Record Type) as indicated below:

![Figure 16 - Determining a Record Type from search results]
4 Understanding Locations

Locations are used in TRIM to track the whereabouts of files and to apply access control for security on restricted records. Locations can be people, organisational units or groups. TRIM users will encounter locations when saving electronic records, undertaking file movements and viewing records in a search results screen.

- Locations are used in the registration and management of records and include the following types:
  - **Creator** – recorded automatically, picked up from login of person creating the record
  - **Home location** – defaults set on all record types, shows the physical location of a file when not in use; for Student Files shows the Student’s campus
  - **Owner location** – defaults set on all record types with manual override, shows ownership of a file
  - **Author** – used on the Central and HR Document record types
  - **Addressee** – used on the Central and HR Document record types
  - **Assignee** – used to show the current location of a file

- Locations in TRIM are either internal or external and can be of the type Person, Organisation (business unit) or Group as follows:

![Favourite Locations - 6 Locations Found]

A GREEN icon indicates an **Internal** location and will be an:
- Organisation
- Person, or
- Group.

A RED icon indicates an **External** location and will be an:
- Organisation, or
- Person.

*Figure 17 - Location Types – Persons, Organisations and Groups*
4.1 **Internal Locations**

Internal locations are used to indicate Monash staff, groups and organisational units.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Location Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Person" /></td>
<td>Person</td>
<td>Includes the full name, network login and organisation (business unit) for all Monash staff members.</td>
</tr>
<tr>
<td><img src="image" alt="Group" /></td>
<td>Group</td>
<td>Used to define a number of record access groups. Is prefixed by <em>Security Group:</em> followed by the name/purpose of the group.</td>
</tr>
<tr>
<td><img src="image" alt="Organisation" /></td>
<td>Organisation</td>
<td>Includes the full name of all Monash organisational units and their members i.e. persons and organisations (sub-units).</td>
</tr>
</tbody>
</table>

4.2 **External Locations**

External locations are used to record information about senders or recipients of correspondence who are external to Monash University. The following conventions apply:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Location Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Person" /></td>
<td>Person</td>
<td>Full name (or initial if first name is not known) and associated with the organisation they work for (where applicable). For Students, full name, Monash student email address and student ID.</td>
</tr>
<tr>
<td><img src="image" alt="Organisation" /></td>
<td>Organisation</td>
<td>Full name only</td>
</tr>
</tbody>
</table>

4.3 **Locations Maintenance**

Internal locations require maintenance to keep up to date. Locations are maintained manually once notification of a staff or organisational unit change has been received.

The TRIM System Administrator is responsible for maintenance. The Administrator also adds new users and deactivates users who no longer require access to TRIM. Deactivating users is important to keep the system up to date.

External locations can be added by users when registering documents e.g. correspondence received from external sources. Refer to Section 7.4 – Adding a New Contact for more information.
5 Searching

5.1 Find Records Functionality

TRIM’s Find Records search function is used to locate records. The basics of TRIM searching are:

- Select a Search Method
- Enter a Search Value

To initiate a search first select the Find Records icon on your toolbar to display the Find Records dialog box:

![Find Records dialog box](image)

Figure 18 - Find Records dialog box

5.1.1 Search Tab

The Search By field displays the selected search method i.e. the TRIM field that you wish to use. TRIM has a large number of fields to select from when searching.

You can select a search method using either the Drop-Down arrow for a recently used search method or by clicking the KwikSelect button to select a new search method.
The KwikSelect button opens the Search Methods dialog box. This dialog box lists all of TRIM's search methods by category. To display the search methods in a category click the plus sign:

![Search Methods dialog box]

*Figure 19 - Selecting a Search Method by Category*

To display a list of all search methods in alphabetical order click on Details:

![Search Methods dialog box with alphabetical list]

*Figure 20 - Selecting a Search Method by Description*
The Drop-Down arrow will display a list of (up to) the last 25 recently used search methods. The items within the Drop-Down list are in most recently used order.

![Figure 21 - Selecting a Search Method from the Drop-Down list](image)

Once you have selected a search method TRIM will display the appropriate search value options.

Depending on the search method selected, TRIM will change the name of the field into which you enter your search value (e.g. Equal to, Date From/Date To, From/To). These are logically named and most fields include a KwikSelect and/or drop-down list or, for date fields, a calendar button to help you select a search value.

### 5.1.2 Sort Tab

A search can be sorted so that it is displayed in a specific order. You can sort by the following:

- No Sort
- Record Number
- Title (Free Text Part)
- External ID
- Date Registered
- Date Created
- Date Due
- Date Closed
- Priority
- Consignment
- Date Inactive
- Last Action Date
- Record Type
- Title (Structured Part)
- Date Declared As Final
- Date Published
- Date Last Updated
A search can be sorted by up to three fields. The first field takes precedence, then the second, and finally the third. Each sort field can be displayed in either ascending or descending order. By default, the sort field will be displayed in ascending order. To change to descending order, check the Descending checkbox.

### 5.1.3 Filter Tab

A search can be filtered so that only required records will be displayed in the search results. To filter a search, click on the Filter tab and check the items you wish to have included in your search. Each of these is described below:
Record Disposition
The Disposition filter allows you to include or exclude records that are archived or are no longer current (inactive) from your search result.

Record Class
The Record Class filter allows you to refine the search to return only the class of records required.

Note: All records at Monash are Corporate.

Finalised Filters
The Finalised Filters option allows you to decide whether to include in your search result any electronic documents that are Not Declared As Final, or that are Declared As Final, or you can choose to display both finalised and unfinalised documents by selecting Either.

Note: All electronic documents saved into TRIM at Monash are Final.

File Types
The File Types filter allows you to refine the search to return only electronic documents or a specific type of electronic document. Enter *.* to find only records that meet the search criteria and have an associated electronic document. Enter a document extension e.g. DOC to find only records which have an associated Microsoft Word document.

Record Types
The Record Types filter allows you to select specific record types by tagging them individually.

You can also select all Document or all Folder record types by firstly selecting Untag All from the right-click menu and then selecting an option from Right-Click > Tag Every.
The filters can be saved by checking the Save as Default Filters checkbox. This action will force TRIM to only display those records that match these filters each time a search is conducted.

### 5.1.4 Conducting a Simple Search

To conduct a simple search:

1. Click the Find Records toolbar icon to display the Find Records dialog box.
2. Select a search method by clicking the Drop-Down arrow on the Search By field to show your recently used search methods, or by clicking the KwikSelect button to select a new search method.
3. Enter a search value into the Equal To field.
4. Use the Sort tab or Filter tab to return records in a particular order or to return records that match the filters selected.
5. Click the OK button.

**Note:** The Open button [Open] on the Find Records dialog box gives you access to your saved searches. (Refer to Section 6 - Saved Searches for details).

### 5.1.5 Using Multiple Search Criteria

You can combine search methods to narrow (or broaden) a search result. This can be done from a new search, or when refining an existing search result.
1. Start a new search or choose the Refine Search toolbar icon to change the criteria for the current search.

2. Insert the first search method and search value (if refining a search this will already be displayed).

3. Click the New button to insert a new search method.

4. Select the required search method and insert the search value.

5. Select the appropriate search combination option: AND, OR or NOT.

6. Repeat Steps 3 to 5 until all search criteria are entered.

7. Click the OK button.

For example, to search for a document registered on June 30, 2007 that has Janet Brennen as its author:

![Image of Find Records window]

Note:
The AND combination will only return those records that meet all search criteria. An AND search narrows a search, returning fewer records but pinpointing the required records.

The OR combination will return all records that meet any of the search criteria. This broadens a search, returning more records and including a wider subject range.

The other options available for advanced searching are as follows:

Figure 25 - Searching using multiple Search Criteria
New
The New button adds a new line to your search at the bottom of your existing criteria.

Insert
The Insert button adds a new line to your search, positioning it above the selected criteria.

Delete
The Delete button will delete the highlighted search criteria from the Current Selection Box.

(…)
The Brackets button will enable you to group search criteria together. This has the effect of mathematical brackets, whereby lines that are bracketed are always dealt with together as one, and will precede any other operations. The Brackets (…) button will remain greyed out until two or more search lines are selected.

NOT
The Not button allows you to exclude records from the search results. If you have tagged search criteria the Not function will exclude all tagged criteria.

Reset
The Reset button will delete (once you confirm) all search criteria from the Current Selection Box, allowing you to construct a new Search.

For more information on Searching see the TRIM Online Help User Guide – Chapter 3 - Search.

5.1.6 Refining a Search

When the search result list is too long, or you want to refine the list to pinpoint the records you are looking for, you can refine the search by using the Refine Search toolbar icon or selecting the F7 shortcut.

This will enable you to change the search method or the search criteria as required. This may include adding or deleting search methods, search values, filtering or sorting.

5.2 TRIM Search Methods

There are numerous search methods a user can choose from to find records in TRIM (refer Section 5.1.1 – Search Tab).

Commonly used search methods and example search values are shown below:

<table>
<thead>
<tr>
<th>Search methods</th>
<th>Example search values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Word Searches</td>
<td>Single or multiple words, can include wildcard (*): NHMRC</td>
</tr>
<tr>
<td></td>
<td>chemical</td>
</tr>
</tbody>
</table>

Note: Searches are not case-sensitive.
<table>
<thead>
<tr>
<th>Search methods</th>
<th>Example search values</th>
</tr>
</thead>
</table>
| Notes Word, Title Word | Raymond Phelps  
angela cauc*  
carpark* policy         |

**Numbers**

<table>
<thead>
<tr>
<th>Record Number</th>
</tr>
</thead>
</table>
| Type in a specific record number or type part of a record number and click the KwikSelect button:  
CF06/1  
RMO2006 [+ KwikSelect] |

**Dates**

<table>
<thead>
<tr>
<th>Date Created, Date Registered</th>
</tr>
</thead>
</table>
| Type in a specific date or using the calendar button, select a date or use a standard date phrase:  
27/7/06 or 27/07/2006  
Previous month  
This year |

**Additional Fields**

<table>
<thead>
<tr>
<th>Signature Date, Staff ID, UCollect Item Type</th>
</tr>
</thead>
</table>
| Select from a list using the KwikSelect button or enter a value.  
14/04/08  
00025510  
RMO-FILE |

**Locations**

<table>
<thead>
<tr>
<th>Addressee, Assignee, Author, Creator</th>
</tr>
</thead>
</table>
| Type the full location name or type part of a location name and click the KwikSelect button:  
Me  
Palm*  
Brennen [+ KwikSelect]  
Cauchi, A [+ KwikSelect]  
My Unit  
My Unit+ (for all staff within your business unit)  
Research Office [+ KwikSelect]  
*Solicitor* |

### 5.2.1 Word Searches

<table>
<thead>
<tr>
<th>Search Method</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Title Word** | Any word that appears in a record's title.  
You can perform a wildcard search by typing in the start of a word before the asterisk (for example adm*). If you enter more than one word, TRIM will do a Boolean AND combination of the two words and return a list of records that have both words in the title. |
| **Notes Word** | Any word that appears in the notes attached to a record.  
Search as for Title Word. |
<table>
<thead>
<tr>
<th>Search Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any Word</td>
<td>TRIM searches both the Title Word and the Notes field.</td>
</tr>
<tr>
<td></td>
<td>Search as for Title Word.</td>
</tr>
<tr>
<td>Document Content</td>
<td>Any word contained in the text of an electronic document. Also known as a</td>
</tr>
<tr>
<td></td>
<td>full text search.</td>
</tr>
<tr>
<td></td>
<td>If you enter more than one word, TRIM will search for the phrase. Choose</td>
</tr>
<tr>
<td></td>
<td>the Kwikselect button on the Search For field for other options e.g. In the</td>
</tr>
<tr>
<td></td>
<td>same Paragraph as...</td>
</tr>
</tbody>
</table>

### 5.2.2 Date Searches

<table>
<thead>
<tr>
<th>Search Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date Created</td>
<td>The document date i.e. the date the document was created.</td>
</tr>
<tr>
<td>Date Registered</td>
<td>The date the record was registered in TRIM.</td>
</tr>
</tbody>
</table>

Date field searches appear as a date range with the current date entered by default:

<table>
<thead>
<tr>
<th>Search By</th>
<th>Date Registered</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date From</td>
<td>30/06/2008</td>
</tr>
<tr>
<td>Date To</td>
<td>30/06/2008</td>
</tr>
</tbody>
</table>

The date can be changed manually or by clicking on the Calendar button and selecting a date. The calendar Drop-Down arrow includes other date search options e.g. This Week, Previous Month:
### 5.2.3 Additional Field Searches

A number of Additional fields have been created to meet the requirements of Monash University. These provide users with additional search capabilities:

<table>
<thead>
<tr>
<th>Search Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accession History</td>
<td>Used by Monash University Archives to indicate access history.</td>
</tr>
<tr>
<td>Accession Number</td>
<td>Used by Monash University Archives to record accession number.</td>
</tr>
<tr>
<td>MUA</td>
<td></td>
</tr>
<tr>
<td>Agreement Date</td>
<td>Agreement date of legal documents.</td>
</tr>
<tr>
<td>Creating Agency</td>
<td>Used by Monash University Archives to record the agency that created the records.</td>
</tr>
<tr>
<td>End Date</td>
<td>End date of legal documents.</td>
</tr>
<tr>
<td>Location – Repository</td>
<td>Used by Monash University Archives to record physical location of items.</td>
</tr>
<tr>
<td>Movement History</td>
<td>Captures the movement history for records migrated from UCollect.</td>
</tr>
<tr>
<td>Legacy</td>
<td></td>
</tr>
<tr>
<td>No End Date</td>
<td>Field used to provide information on a legal document where no end date has been provided.</td>
</tr>
<tr>
<td>Provenance</td>
<td>Automatically captures the organisational details of the user registering records into TRIM into a read-only field.</td>
</tr>
<tr>
<td>Reactivate Date</td>
<td>Used by Monash University Archives to show when a staff file has been reactivated.</td>
</tr>
<tr>
<td>Signature Date</td>
<td>Signature date on legal documents.</td>
</tr>
<tr>
<td>Staff ID</td>
<td>Used by Human Resources to record Staff ID.</td>
</tr>
<tr>
<td>Start Date</td>
<td>Start Date of legal documents.</td>
</tr>
<tr>
<td>Student ID</td>
<td>Used by Records and Archives Services to record Student ID.</td>
</tr>
<tr>
<td>Student Type</td>
<td>Used by Records and Archives Services to record Student Degree Type.</td>
</tr>
<tr>
<td>Termination Date</td>
<td>Used by Human Resource to indicate termination date of visiting staff.</td>
</tr>
<tr>
<td>Transferring Agency</td>
<td>Used by Monash University Archives to record the agency that transferred the records to Archives.</td>
</tr>
<tr>
<td>UCollect Item ID</td>
<td>Records the Item Type on records migrated from a previous Records Management System.</td>
</tr>
<tr>
<td>UCollect Status</td>
<td>Records the Status information on records migrated from a previous Records Management System.</td>
</tr>
<tr>
<td>Search Method</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>UCollect Status Date</td>
<td>Records the Status Date on records migrated from a previous Records Management System.</td>
</tr>
</tbody>
</table>

### 5.2.4 Location Searches

<table>
<thead>
<tr>
<th>Search Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assignee</td>
<td>Shows the current location of a hard copy file or box.</td>
</tr>
<tr>
<td>Author</td>
<td>The author of the document.</td>
</tr>
<tr>
<td>Creator</td>
<td>The name of the logged on user who registered the record in TRIM.</td>
</tr>
</tbody>
</table>

Location field searches appear with name of the logged on user entered by default:

- **Search By**
  - **Creator**

- **Location**
  - **Dodge, Nicole (Miss)**

To search for another user, delete the value displayed, enter their last name (or start of their last name) and choose the Kwikselect button. TRIM will display a list of locations:

If the location you want is listed highlight it and choose the OK button to enter it as your search value.

Choose the Search button to change your search criteria. TRIM will display the Search for Locations dialog box:


<table>
<thead>
<tr>
<th>Search Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Replace the current search value and choose the OK button to run the search.</strong></td>
<td></td>
</tr>
</tbody>
</table>

**Location Search Tips:**

- You can also search for personal names in the following ways:
  - Brennen, j
  - Brennen, janet
  - *janet* (which will also retrieve Janette)

Use *Me* or *My Unit* to simplify the record search.

Append a plus sign (+) to the Location to search a location and its members e.g.

- **Assignee = University Solicitor+**

This search will find any records assigned to the location University Solicitor or to University Solicitor staff members.

---

5.3 **Other Search Options**

5.3.1 **Using the Find Records Pane**

Using the Find Records Pane reduces the number of key strokes required to run a single criteria search.

The Kwikselect button and Drop-Down arrow work as described in 5.1.1. – Search Tab. Press the Find button at the end of the Find Records Pane or the Enter key to run the search.

5.3.2 **Navigate**

The Related Records and All Parts toolbar icons can be used to navigate from a record to its related records. Double-clicking on the folder in the view pane will navigate from a document to its file and clicking the plus sign next to a file will display the documents within it.
Additionally, the Right-Click > Navigation menu will display all of the navigation options relevant for the highlighted record. Choose the appropriate option to navigate to the related records.

Navigate options include:

<table>
<thead>
<tr>
<th>Navigation Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contained Within</td>
<td>Displays all records contained within the highlighted record e.g. the Documents on a file or the files within a box.</td>
</tr>
<tr>
<td>Container Record</td>
<td>Displays the file on which a document has been placed or the box in which a file is contained.</td>
</tr>
<tr>
<td>Container Records (+Alternative)</td>
<td>Where a document has been “alternatively contained” within another file, displays both files.</td>
</tr>
<tr>
<td>All Parts</td>
<td>Displays all parts of a file.</td>
</tr>
<tr>
<td>Latest Part</td>
<td>Displays the latest part of a file.</td>
</tr>
<tr>
<td>Records with Same Contacts</td>
<td>Displays records which have the same contact as the highlighted record e.g. that have the same author.</td>
</tr>
<tr>
<td>Related Records</td>
<td>Displays all records that have been related to the highlighted record.</td>
</tr>
</tbody>
</table>

### 5.3.3 Favourites

TRIM allows users to create shortcuts to their Favourite Records, Locations, Classifications and Saved Searches. This enables the user to quickly find these again by clicking on the relevant option on the Favourites shortcuts toolbar.

To mark an item as a favourite, select it and:
- Right click > Send to > Favourites; or
- F4 (shortcut key)

To access a favourite click on the relevant shortcut icon or:
- Alt+F3 for Favourite Records
- Ctrl-I from within the locations list for Favourite Locations

To remove an item from Favourites, select it and:
- Right click > Remove from > Favourites; or
- Ctrl-Delete

**Tip:** You can tag multiple records, locations etc. by clicking and ticking with your mouse to the left of the record icon.
5.3.4 Browsing via Classifications

The Browse via Classification search method allows you to browse to a TRIM record using the Monash Classification structure. Browse via Classification enables you to drill down through the classification structure until you locate your file or record (like Windows Explorer).

To Browse via Classifications:

1. From the Search menu select Browse via Classifications.
2. TRIM displays a list of Functions:

   ![Figure 26 - Classifications - Function List](image)

   **Figure 26 - Classifications - Function List**

3. Each Function includes a number of Activities. Access the Activities by selecting the plus + key next to the Function. Where files have been created they will appear under the relevant Activity:

   ![Figure 27 - Classifications - Browsing Functions and Activities to find a file](image)

   **Figure 27 - Classifications - Browsing Functions and Activities to find a file**

**Tip:** To display all files for a particular Activity in a new window (e.g. so that you can print a report or sort them alphabetically by title) right-click on the relevant Activity and choose Show Records (or use Ctrl-R). You can create shortcuts to your favourite classifications (refer section 5.3.3 – Favourites for details).
6 Saved Searches

6.1 Saving Searches

It is possible to save search criteria for future use. This is helpful if you regularly conduct the same search or similar searches to find records for reporting purposes. TRIM saves the search criteria for re-use, not the actual search results.

6.1.1 Saving a Search

1. Conduct the search that you wish to save.
2. From the File menu, select Save Search.
3. The New Saved Search dialog box will appear:

   ![New Saved Search dialog box](image)
   
   *Figure 28 - New Saved Search dialog box*

4. Enter the following details on the General tab:
   - Name – enter a name for your search. Choose a name that will be easy to identify the next time you use the saved search list. A maximum of 30 characters can be used to name the saved search. Each saved search name must be unique.
   - Description – enter a description to provide more detail about the search. By default TRIM inserts the search method and value.
5. Tick the check-box to add this saved search to your Favourites. This allows you to easily find them again.
6. If you wish to modify the Search, Sort or Filter options, do so from the relevant tab.
7. Click the OK button to create the saved search.

**Note:** When saving searches that include dates e.g. Date Registered, use a metadata variable. For instance, if you want to do a daily search for records registered that day you should use the metadata variable Today. This way you will always get the current day’s records.

You can choose from the following metadata variables:

- Next 12 Months
- Next 14 Days
- Next 30 Days
- Next 6 Months
- Next 7 Days
- Next Month
- Next Week
- Next Working Day
- Previous 12 Months
- Previous 14 Days
- Previous 30 Days
- Previous 6 Months
- Previous 7 Days
- Previous Month
- Previous Week
- Previous Working Day
- This Month
- This Week
- This Year
- Today
- Tomorrow
- Year To Date
- Yesterday

### 6.1.2 Accessing a Saved Search

1. To access a saved search choose one of the following:
   - From the Search menu, select Saved Searches, or
   - Select the Find Records toolbar icon and then click the Open button on the dialog box, or
   - Select the Saved Searches icon from the Favourites shortcuts (if you’ve added the search to your Favourites)

   A list of saved searches will appear.

2. Double-click on a saved search to run it, or

3. Highlight the saved search and press F4 to send it to your Favourite searches.
7 Saving and Viewing Electronic Records

7.1 Guidelines for scanning documents to PDF for registration in TRIM

The preferred format for scanning is PDF. Be aware that different types of PDF documents can be generated by Adobe Acrobat. To enable TRIM to index the content of a document you should include optical character recognition (OCR) of text when scanning documents where available.

You should also use the following parameters to keep the image size as compact as possible:

<table>
<thead>
<tr>
<th>Variable</th>
<th>Recommended</th>
<th>Rationale</th>
</tr>
</thead>
<tbody>
<tr>
<td>Colour Mode</td>
<td>Black and white <em>(Note: Colour is the default setting on Monash multifunction devices)</em></td>
<td>Scanning in colour increases the size of the document significantly and is harder to read on the screen. Black and white scanning is preferred except where colour is integral to understanding the document e.g. the document refers to items in red text.</td>
</tr>
<tr>
<td>Resolution</td>
<td>200 DPI <em>(default setting on Monash multifunction devices)</em></td>
<td>Dots Per Inch (DPI) must be greater than 150 to facilitate Content Indexing. 200 DPI is ideal for printed text and also shows most fine lines such as table borders. <em>(Note: DPI will need to be increased to 300 where the document is handwritten or includes a substantial amount of handwritten text.)</em></td>
</tr>
</tbody>
</table>

7.2 Saving an Electronic record

There are two options for saving electronic records into TRIM. These are the Drag and Drop and Send To.

To save an electronic document using **Drag and Drop**:

1. Open and then minimise TRIM.
2. Open Windows Explorer. Find the document you wish to save to TRIM.
3. Drag the document from Explorer onto the TRIM icon on the taskbar. When TRIM maximises, move your mouse into TRIM and release it. Don’t
release the mouse until TRIM maximises and you see a small plus + sign beneath your cursor).

4. By default the Select from Record Types dialog box will appear. Highlight the relevant record type and click the OK button.

   **Note:** If you have set a default record type its registration screen will appear. (Refer to Section 2.5.2 for instructions on setting a default record type).

5. Complete all the required fields on the registration screen as described in Section 7.2.2 – 7.2.4 and select the OK button to save the record.

6. The saved record will be presented to you in a new window.

To save an electronic document using **Send To**:

1. Open Windows Explorer. Find the document you wish to save to TRIM.
2. Right-click on it and select Send to > TRIM.
3. Depending on your settings either the relevant registration screen or the Select from Record Types dialog box will appear. Continue to register the document as per the Drag and Drop instructions.

   **Note:** TRIM stores a copy of the electronic document; the original is retained on your network drive. The copy in TRIM is final; no changes can be made to the document.

### 7.2.1 General Guidelines for Document Titling

Be specific and consistent in titling documents.

Create titles so that documents are easily distinguished from each other in a title list. For example, titling a document *Research Application* does not tell you who the researcher or granting body is and what the research application is for.

Try not to use abbreviations as they may mean different things to different people. They also change over time (e.g. HSC, VCE) making documents difficult to find when usage is redundant.

Don’t use jargon as it also tends to change over time.

Do not use terms such as *general* and *miscellaneous* in titles.

Do not truncate words, as this will cause problems when searching e.g. *Mtg* for meeting, *BusEco* for Business and Economics.

When using dates in title always use four digits for the year and enter the date in the format YYYYMMDD, e.g. 20071019 for 19 October 2007. This assists in sorting by title.

Use exact names of organisations and full names for individuals.

If the title is longer than the title field continue it in the Notes field. An Any Word search in TRIM will search both Title and Notes fields.

Avoid the use of symbols in the title e.g. !*@% and limit punctuation in titles.
Examples of document titles

Central Documents
1. Research application for funding to Ray and Joyce Uebergang Foundation - Graham Oppy - A history of philosophy in Australia and New Zealand
2. Consultancy Agreement C - The Association of Independent Schools of Victoria - Margaret Gearon - Factors affecting the preparation of Languages Other Than English (LOTE) teachers
3. Plans for proposed School of Physiotherapy Occupational Therapy, Bachelor of Sport and Outdoor Recreation (BSOR) and Education - 15 contract drawings

HR Documents
1. Confirmation of Commencement Janet Citizen 20071217
2. Salary Packaging Confirmation Janet Citizen 20080112

Student Documents
1. Consultation – Course Advice – Janet Citizen
2. Personal Details – Change of Residency Status – Janet Citizen
3. Fees – Sibling Discount – Janet Citizen
4. Fees – Sponsorship – Reconciliation - Janet Citizen
5. Admission – Candidature – PhD – John Citizen
6. Variation – Discontinue – PhD - John Citizen

7.2.2 Completing the Central Document Registration Screen

Figure 29 - Central Document Registration Screen
An asterisk indicates a mandatory field. Complete the fields as follows:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Title</strong></td>
<td>Describe the contents of the document. Guidelines for document titling are described in Section 7.2.1. TRIM automatically populates this field from the Name field in Windows Explorer.</td>
</tr>
<tr>
<td><strong>Date Created</strong></td>
<td>This date should be the date on the document. TRIM automatically populates this field from the Date Modified field in Windows Explorer. <strong>Note:</strong> for scanned documents this date is likely to require modification as it will be the scan date which may not be the date that the document was written. The same issue will apply for emails saved or printed to the desktop for capture to TRIM.</td>
</tr>
<tr>
<td><strong>Author</strong></td>
<td>This field should indicate who wrote the document or signed it. Where the name of the author is unknown this should be an organisation name. Enter the author’s last name and choose the Kwikselect button to select the location from TRIM’s Location List. If the author is not in the Location List, add them as described in Section 7.4 - Adding a New Contact.</td>
</tr>
<tr>
<td>Addressee</td>
<td>This optional field is used for correspondence to show the person or organisation to whom the correspondence is addressed.</td>
</tr>
<tr>
<td><strong>File</strong></td>
<td>This is the TRIM number for the relevant file, e.g. CF07/1933 If you don’t know the number use the Kwikselect button to search for the file.</td>
</tr>
<tr>
<td>Access</td>
<td>Documents inherit their security from their file. Refer to Section 8 - Security and Access Controls for more information.</td>
</tr>
<tr>
<td>Notes Tab</td>
<td>To include additional information choose the Add Notes button from the Notes tab.</td>
</tr>
</tbody>
</table>
7.2.3 Completing the HR Document Registration Screen

Figure 30 - HR Document Registration Screen

A red asterisk indicates a mandatory field. Complete the fields as follows:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
</table>
| * Title      | TRIM automatically populates this field from the Name field in Windows Explorer. The title must be entered in the format:  
              | * Form Name Staff Name Document Date (in format YYYYMMDD)  
              | e.g. Employment Contract Russell Wade 20071031  
              | When entering the date always use four digits for the year and enter the date in the format YYYYMMDD e.g. 20071019 for 19 October 2007. This assists in sorting by title. |
| * Date Created | This date should be the date on the document.  
                  | TRIM automatically populates this field from the Date Modified field in Windows Explorer.  
                  | This date should match the date entered into the Title field.  
<pre><code>              | **Note:** for scanned documents this date is likely to require modification as it will be the scan date which may not be the date that the document was written. |
</code></pre>
<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The same issue will apply for emails saved or printed to the desktop for capture to TRIM.</td>
</tr>
<tr>
<td>* Author</td>
<td>This field should indicate who has completed the form or signed it. Enter the author’s last name and choose the Kwikselect button to select the location from TRIM’s Location List. If the author is not in the Location List, add them as described in Section 7.4 - Adding a New Contact.</td>
</tr>
<tr>
<td>Addressee</td>
<td>This optional field is used for external correspondence to show the person or organisation to whom the correspondence is addressed e.g. Centrelink or Dun and Bradstreet.</td>
</tr>
<tr>
<td>* File</td>
<td>This is the TRIM number for the relevant file, e.g. STAFF07/848. If you don’t know the file number use the Kwikselect button to search for the file.</td>
</tr>
<tr>
<td>Notes Tab</td>
<td>To include additional information choose the Add Notes button from the Notes Tab.</td>
</tr>
</tbody>
</table>

### 7.2.4 Completing the Student Document Registration Screen

![Student Document Registration Screen](image)

*Figure 31 - Student Document Registration Screen*
A red asterisk indicates a mandatory field. Complete the fields as follows:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
</table>
| *Title      | TRIM automatically populates this field from the Name field in Windows Explorer. The title should be entered in the format: Document Information - Student Name  
  e.g. Deferment Request - Janet Citizen |
| *File       | This is the TRIM number for the relevant file i.e. the Student ID number. If you don’t know the file number use the Kwikselect button to search for the file. |
| *Date Created | This date should be the date on the document. TRIM automatically populates this field from the Date Modified field in Windows Explorer.  
  This date should match the date entered into the Title field.  
  **Note:** for scanned documents this date is likely to require modification as it will be the scan date which may not be the date that the document was written. The same issue will apply for emails saved or printed to the desktop for capture to TRIM. |
| Access      | Documents inherit their security from the file. All access controls except Destroy Record must be changed on sensitive documents e.g. relating to Academic Progress, Grievances and Special Consideration only.  
  **Tip:** Refer to Section 8.2.4 - Changing Access Controls on Student Files and Documents for more information. |
| Notes Tab   | To include additional information choose the Add Notes button from the Notes Tab. |

### 7.3 Saving an Email

#### 7.3.1 Thunderbird

1. From Thunderbird highlight the email and save as a .EML file as follows:
   a. Choose File > Save As > File or use Ctrl+S (shortcut).
   b. Select Save As Type Mail Files (*.EML) and save to the desktop.
2. Highlight the .EML file on the desktop and use either Send To > TRIM or Drag and Drop to save it to TRIM.
3. Register the document as described in Section 7.2. – Saving an Electronic Document. Note that the Date Created will be the date that the email was saved to the desktop. This date should be modified, where required, to reflect the date the email was sent.

7.3.2 Lotus Notes

1. From Lotus Notes highlight the email and save as a .TIF file as follows:
   a. Choose File > Print or use Ctrl+P (shortcut).
   b. Select PDF (if available) or Microsoft Office Document Image Writer from the Name dropdown and save to the desktop.

2. Highlight the file on the desktop and use either Send To > TRIM or Drag and Drop to save the file to TRIM.

3. Register the document as described in Section 7.2. – Saving an Electronic Document. Note that the Date Created will be the date that the email was saved to the desktop. This date should be modified, where required, to reflect the date the email was sent.

7.3.3 Saving an Attachment to a Lotus Notes Email

When saving an email from Lotus Notes as described above attachments are not saved. Where both the email and attachments are to be saved to TRIM they need to be saved separately and then related as follows:

1. From Lotus Notes save the attachment to the desktop.

2. Use either Send To > TRIM or Drag and Drop to save the file to TRIM.

3. Relate the attachment to the email in TRIM as follows:
   a. Open Recent Documents.
   b. Highlight the email record; highlight its record number in the View Pane and Ctrl-C to copy it.
   c. Highlight the attachment and choose the Relate Records To toolbar icon.
   d. On the Relationship Type field use the Kwikselect button to select Attachment Of.
   e. With the cursor in the With Record field Ctrl-V to paste the record number of the email.
   f. Choose OK to save.
   g. Repeat for additional attachments.

**Tip:** To relate several attachments to the email, tag the relevant records and then follow steps d – f above.

When either the email or the attachment is highlighted choose the Related Records toolbar icon to display the email and its attachments.
7.4 Adding a New Contact

When registering Central or HR documents a new Contact location will need to be created if the author of a document or email is not in the TRIM Location list. This will generally be a person and/or organisation external to Monash University.

**Note:** To avoid the creation of duplicates ensure that you have undertaken a thorough search of the Location List before creating a new Contact.

**Tip:** Always use a wildcard search before creating an Organisation location to confirm that it does not already exist e.g.

*Research* (will find locations that have Research anywhere in their name e.g. Accident Research Centre)

7.4.1 Creating an Organisation Location

1. Search the Location list to confirm that the location does not already exist, then
2. From the right-click menu select New Location > New Organisation. The New Organisation dialog box will appear with the information you used to search the location list in the Name field:

![New Organisation dialog box](image)

*Figure 32 - New Organisation dialog box*

3. Enter the name of the organisation in Title Case and select the OK button to create the location.
7.4.2 Creating a Person Location

**Note:** Where the organisation is known a person should always be associated with their organisation.

1. Search the Location list to confirm that the location does not already exist, then
2. Find the relevant organisation in the Locations list, then
3. Right-click on the organisation and select New Child Location > New Child Person. The New Person dialog box will appear:

![New Person dialog box](image)

*Figure 33 - New Person dialog box*

4. Select the Details button and enter Title, First Names and Last Name in Title Case:
5. Select the OK button to return to the New Person screen.

6. If you know the person’s email address this should be entered. From the Electronic Addresses tab right-click and choose Email:
7. The New Email dialog box will appear:

![New E-mail dialog box](image)

Figure 36 - New E-mail dialog box

8. Enter the email address and select the OK button to add it.
9. Select the OK button to create the location.
10. Use the + sign on the organisation to display the person location.
11. Select the OK button to enter the location on the document registration screen.

**Note:** For duplicate personal names a postcode can be added to the Notes field to help distinguish individuals.

### 7.4.3 Creating a location for a Monash Staff Member

Internal locations are created by the TRIM System Administrator once notification of a new staff member is received. If the staff member has not yet been added to the TRIM Locations List either advise Records and Archives Services or add the staff member to the Locations List (remembering to associate them with their organisational unit).

**Note:** Where a location for a staff member is created by anyone other than the TRIM System Administrator they will be created as an external location. Ensure that you advise Records and Archives Services when you add a staff member so that the location can be updated to an internal location and given the appropriate user profile.

### 7.5 Viewing a Record’s Properties

To view a record’s Properties (i.e. the metadata information for a record):
1. Highlight the record in TRIM.
2. Right-click and select Properties (or use the Alt-Enter shortcut).
3. The record’s properties i.e. the registration screen will appear.

**Note:** The properties displayed will vary depending on the type of record you’ve selected. If a field is greyed-out, then it is not able to be altered. You can view the properties of any record you have access to.

### 7.6 Viewing an Electronic Document

To view an electronic document:
1. Highlight the record in TRIM.
2. Select the View icon from your toolbar.
3. The document will launch in its native application for viewing and will be read-only.

### 7.7 Emailing an Electronic Document

To email an electronic document:
1. Highlight the record in TRIM.
2. Right-click and select Send To > Mail Recipient and choose either TRIM Record Reference or Electronic Document:

![Figure 37 - Send to Mail Recipient screen](image)

If you are sending the document to a member of staff who has access to TRIM you should choose TRIM Record Reference. This is a shortcut to the record in TRIM; it appears as an email attachment and, when opened, opens TRIM and displays the record.

Choose Electronic Document to send a copy of the document.
3. By default, TRIM will include the Record Number and Title of the record in the text of the email. This default setting can be changed from the Metadata tab:

![Send To Mail Recipient Metadata Tab](image)

**Figure 38 - Send to Mail Recipient Metadata Tab**

4. Use the Add and Remove buttons to determine what (if any) metadata is to be included in the email. This information can be sent in an email attachment by choosing the option Attach to Message as a Separate Document.

5. Select the OK button and a new email message screen will appear with the document or TRIM reference as an attachment.

6. Complete and send the email in the usual way.

### 7.8 Double-clicking in TRIM

The effect of double-clicking on a record varies depending on the type of record, as follows:

<table>
<thead>
<tr>
<th>Double-clicking on...</th>
<th>Will...</th>
</tr>
</thead>
<tbody>
<tr>
<td>A file that has attached documents</td>
<td>Displays file contents in a new window</td>
</tr>
<tr>
<td>A box that has enclosed records</td>
<td>Displays box contents in a new window</td>
</tr>
<tr>
<td>A file or box without any attached documents or enclosed records</td>
<td>Displays the Properties of the file or box</td>
</tr>
<tr>
<td>An electronic document</td>
<td>Displays the electronic document in its native application</td>
</tr>
<tr>
<td>A non-electronic document</td>
<td>Displays the Properties of the document</td>
</tr>
</tbody>
</table>
8 Modifying Records

8.1 Changing a Title

The title of a document can be changed if necessary e.g. to correct a typing error.

To change the title:
1. Find the document.
2. From the right-click menu choose Properties.
3. Make the changes to the title and choose the OK button to save them.

8.2 Changing the File

A document can be moved to a different file in TRIM e.g. where it has been filed incorrectly. All users can move a document to a different file (unless prevented by the access controls on the document).

To change the file:
4. Find the document or documents.
5. From the right-click menu choose Locations > Container.
6. If moving multiple documents to the same file tag each document and click the OK button at the prompt Apply To All Tagged Rows.

7. Delete file number displayed in the Set Container To field.
8. Click the KwikSelect button and search for the file as described in Section 5 - Searching.
9. Select the appropriate file from the list that is returned.
10. Click the OK button to change the file.
11. If moving multiple documents, you will be asked to confirm the action Record Container– All Tagged Records. Select Yes to All.

8.3 Adding a Note

All users can add a note to a record in TRIM (unless prevented by the access controls on the record). Existing notes cannot be edited.

To add a note:

1. Find the record or records.
2. Choose the Notes toolbar icon.

![Figure 40 - Add Note](image)

3. Choose Add Notes.
4. If adding a note to multiple records tag each record and click the OK button at the prompt Apply To All Tagged Rows.
5. Enter a note.

**Note:** The first time you add a note to multiple records ensure that you check At the Start and Insert the new notes with user stamp:
6. Click the OK button to add the note.
7. If adding a note to multiple records you will be asked to confirm the action Record Notes – All Tagged Records. Select Yes to All.
8. Click the OK button to save the note.
9. The note will be added before any existing notes and will be prefixed with a user stamp.

8.4 Relating Records

Associations can be made between records in TRIM. Files can be related to other files or to a document; a document can be related to a file other than the file that it is contained within or to other documents.

To relate a record:
1. Find the record or records.
2. Choose the Relate toolbar icon.
3. If relating multiple records tag each record and click the OK button at the prompt Apply To All Tagged Rows.
4. Choose the Search button and search for the record or records you wish to relate to the current record as described in Section 5 - Searching.

5. Highlight the record or tag multiple records and choose OK. The records will appear in the list.

   **Tip:** If you know the number of the record you wish to relate, instead of following steps 4 & 5 enter the number in the With Record field and click the Add button. The record will appear in the list.

6. Click the OK button to relate the records.

7. If relating multiple records you will be asked to confirm the action Relate Records To – All Tagged Records. Select Yes to All.

To view related records:
Where records have been related to other records the Related Records toolbar icon will be active.
Click the icon to display the current record and its related records.

### 8.5 Updating Student Records

#### 8.5.1 Changing the Title of a Student File

When a student changes their name:

The previous name should be added to the notes field with the prefix Name Change: e.g. *Name Change: Janet Citizen*

The title of the Student File should be changed.

To add a note:

1. Find the student file, highlight the title field in the View Pane and use Ctrl-C to copy it.
2. Choose the Notes toolbar icon.
3. Choose Add Notes.
4. Enter the prefix *Name Change:* and use Ctrl-V to paste in the previous name.
5. Click the OK button to add the note.
6. Click the OK button to save the note.

To change the file title:
1. Right-click on the record and choose Properties. The registration screen will appear.
2. Change the student name.
3. Click the OK button to save the change.
4. For hard copy Clayton files change the name on the file cover so that a new label will be printed when the file is returned to Student Records.

### 8.5.2 Associating a Student Document with a Central file

Associations can be made between records in TRIM. Where a Student Document is relevant to a Central File as well as the Student File it can be associated as being Alternatively Within that file. When this association is made the document will appear in each file.

To put a Student Document Alternatively Within another file:

1. Find the document or documents.
2. Choose the Relate toolbar icon.
3. If relating multiple records tag each record and click the OK button at the prompt Apply To All Tagged Rows.
4. Use the dropdown arrow at the end of the Relationship Type field to select Alternatively Within.

**Note:** You will only need to perform this step the first time you use this functionality as TRIM will remember the setting.

![Figure 43 - Select Alternatively Within](image)
5. Choose the Search button and search for the relevant file as described in Section 5 - Searching.

6. Highlight the file and choose OK to add the record to the list.

   **Tip:** If you know the number of the file you wish to relate, instead of following steps 5 & 6 enter the number in the With Record field and click the Add button. The record will appear in the list.

7. Click the OK button to save the setting.
9 Security and Access Controls

TRIM provides a comprehensive security system to control access to records, allowing individuals or groups to be assigned customised access.

Access restrictions in TRIM are placed on the file. Any documents contained within that file will inherit the same restrictions.

If a user does not have View Metadata access to a record, then that record will be invisible to them in TRIM i.e. the user will not know that it exists.

![Security/Access](image)

**Figure 44 - Checking the access settings of a record**

9.1 Access Controls

The security model at Monash is implemented using TRIM’s Access Controls. Access Controls are applied to records to restrict the level of access users have to them. Access controls are applied using TRIM’s Locations.

Access is based on business need and is set either on the record type or on individual records as required. Access controls set who can create records and what type of access is granted to records e.g. view, edit etc.

The access controls that allow various users to create records of a particular type are **Record Type Access Controls**. These are a system access control setting that most users won’t see. These restrict the type of activity that can be undertaken using each Record Type. The most important activity that can be set is:

- **Can Use**: This specifies who can create records of this type. This is set by the System Administrator.

Other access controls are set to ensure that when a particular type of record is created, it inherits its access settings from a default model. This means that users creating records don’t need to worry about how to set each record’s access controls. These are called **Default Record Access** settings. Some of these settings relate specifically to documents, while the others relate to both documents and files.

Access Control settings are:

- **View Document**: Determines who can see the electronic document attached to the record.
- **View Metadata**: Determines who can see the descriptive information about the record.
- **Update Document**: Determines who can edit the electronic version of the document. **Note**: This function is not currently in use at Monash.
- **Update Record Metadata**: Determines who can change the descriptive information about the record.
- **Modify Record Access**: Determines who can change the access settings on the record.
- **Destroy Record**: Determines who can destroy the record.
- **Contribute Contents**: Determines who can allocate records to the file.

What access you have to records also depends on your User Category e.g. Inquiry Users can view records, update some details but not others. Administrators have full access rights.

The table below shows the default record access controls set on the Central, Legal, HR and Student Record Types:

<table>
<thead>
<tr>
<th>Record Type</th>
<th>Default Record Access Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central Document</td>
<td><strong>View Document</strong>: Based On Container (inherited from file)</td>
</tr>
<tr>
<td>Legal Document</td>
<td><strong>View Metadata</strong>: Based On Container (inherited from file)</td>
</tr>
<tr>
<td>HR Document</td>
<td><strong>Update Document</strong>: Based On Container (inherited from file)</td>
</tr>
<tr>
<td></td>
<td><strong>Update Record Metadata</strong>: Based On Container (inherited from file)</td>
</tr>
<tr>
<td></td>
<td><strong>Modify Record Access</strong>: Based On Container (inherited from file)</td>
</tr>
<tr>
<td></td>
<td><strong>Destroy Record</strong>: Security Group: Records Disposal</td>
</tr>
<tr>
<td></td>
<td><strong>Contribute Contents</strong>: Based On Container (inherited from file)</td>
</tr>
<tr>
<td>Central File</td>
<td><strong>View Document</strong>: Monash University</td>
</tr>
<tr>
<td></td>
<td><strong>View Metadata</strong>: Monash University</td>
</tr>
<tr>
<td></td>
<td><strong>Update Document</strong>: Monash University</td>
</tr>
<tr>
<td></td>
<td><strong>Update Record Metadata</strong>: Monash University</td>
</tr>
<tr>
<td></td>
<td><strong>Modify Record Access</strong>: Record Owner Location</td>
</tr>
<tr>
<td></td>
<td><strong>Destroy Record</strong>: Security Group: Records Disposal</td>
</tr>
<tr>
<td></td>
<td><strong>Contribute Contents</strong>: Record Owner Location</td>
</tr>
<tr>
<td>Legal Folder</td>
<td><strong>View Document</strong>: Monash University</td>
</tr>
<tr>
<td></td>
<td><strong>View Metadata</strong>: Monash University</td>
</tr>
<tr>
<td></td>
<td><strong>Update Document</strong>: Records and Archives Services &amp; Security Group: LFLD</td>
</tr>
<tr>
<td></td>
<td><strong>Update Record Metadata</strong>: Records and Archives Services &amp; Security Group: LFLD</td>
</tr>
<tr>
<td></td>
<td><strong>Modify Record Access</strong>: Records and Archives Services &amp; Security Group: LFLD</td>
</tr>
<tr>
<td></td>
<td><strong>Destroy Record</strong>: Security Group: Records Disposal</td>
</tr>
<tr>
<td></td>
<td><strong>Contribute Contents</strong>: Records and Archives Services &amp; Security Group: LFLD</td>
</tr>
<tr>
<td>Staff File</td>
<td><strong>View Document</strong>: Human Resources &amp; Security Group: Archives</td>
</tr>
<tr>
<td></td>
<td><strong>View Metadata</strong>: Human Resources &amp; Security Group: Archives</td>
</tr>
<tr>
<td></td>
<td><strong>Update Document</strong>: Human Resources &amp; Security Group: Archives</td>
</tr>
<tr>
<td></td>
<td><strong>Update Record Metadata</strong>: Human Resources &amp; Security Group: Archives</td>
</tr>
<tr>
<td></td>
<td><strong>Modify Record Access</strong>: Security Group: HR Access Controls &amp; Security Group: Archives</td>
</tr>
<tr>
<td></td>
<td><strong>Destroy Record</strong>: Security Group: Records Disposal</td>
</tr>
<tr>
<td></td>
<td><strong>Contribute Contents</strong>: Human Resources &amp; Security Group: Archives</td>
</tr>
<tr>
<td>Student File</td>
<td><strong>View Document</strong>: Security Group: Student Records – View &amp; Records</td>
</tr>
</tbody>
</table>
### Methods of Control

Access Control categories can be applied to specify who (Person, Group or Organisation) is able to perform a particular operation on a TRIM record.

**Note:** To be able to update a record’s details (add a note, move a document to another file, change the assignee, create relationships or change a title) you must be a member of the location that has Modify Record Metadata access for that record.

To be able to change any of the access settings on a record, you must be a member of the location that has Modify Record Access access for that record.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Everyone</td>
<td>Selecting this option means that anyone with access to the TRIM Database will have the specified access to this record.</td>
</tr>
<tr>
<td></td>
<td>It is advised that, if you choose to broadly open up access on a particular record, you use a location or group of locations to do this. Using Monash University will give the specified access to everyone located under Monash University in TRIM’s locations structure.</td>
</tr>
<tr>
<td>Container</td>
<td>This option is usually selected for documents, and will give each document selected the same access setting as the file that the documents have been assigned to.</td>
</tr>
<tr>
<td>Private</td>
<td>This option should not be used. It changes the existing access settings to the currently logged in user only.</td>
</tr>
<tr>
<td>Custom</td>
<td>This option enables the user to customise the access settings on the record.</td>
</tr>
</tbody>
</table>
9.2 Changing Access Controls

The key Access Controls are:

- **View Document**: determines who can view the electronic document.
- **View Metadata**: determines who can find the record in TRIM.
- **Update record Metadata**: determines who can modify a record e.g. add a note, move a document to another file, change the assignee, create relationships or change a title.
- **Modify Record Access**: determines who can change the access settings on the record.
- **Contribute Contents**: determines who can place a document on to the file.

To change Access Controls for a File or Document:

1. Find the record.
2. Click the Security/Access toolbar icon.
3. Tag the access controls you wish to change (point and click to the left of the access control):

![Access Controls](image)

*Figure 45 - Selecting Access Controls to be changed*

4. Click the Custom button and select the option Restricted to the following Locations (and any of their members).
5. Add or remove units or people using the Add and Remove buttons.

**Note:** View Metadata is the most critical access setting. If you’re not part of this access group you will not find the record in TRIM. As a general rule records should be restricted to business units rather than to individuals.
Figure 46 - Adding Access Control Locations

**Note:** Your name will be added by default. As a general rule you should remove your name after adding a location of which you are a member.

6. Click the OK button to make the changes.

7. Click the OK button to save the changes.

**Tips:**
- Before changing access settings on a record take a note of the current settings (in case you want to change them back).
- To change the settings on a document back to those set on its file, follow steps 1 – 4 above and then select the option Same as Container Record.
- If you commonly restrict access to the same group of locations you should save the locations to your Favourites using [F4]. To display your favourite locations click [Ctrl-I] after you have selected the Add button.

### 9.2.1 Central Files and Documents

By default, the ability to view Central Files and Central Documents is open to all Monash University staff. However, Modify Record Access and Contribute Contents access is restricted to members of the file’s Owner Location. These default settings are often changed by Records and Archives Services staff when a file is created so that it can only be accessed by appropriate business units.

Central Documents inherit their access control settings by default from the file they are placed on. It is mandatory to include a file when registering a Central Document.

Generally, access controls on Central Files and Documents will not need to be changed. However, on occasion, you may wish to change their access.

**Note:** The Modify Record Access setting for Central Files is set by default to the business owner of the file. You will only be able to change the access controls on a Central File or Central Document if you are a member of its Owner Group.

### 9.2.2 HR Files and Documents

Staff Files and HR Subject Files are open only to Human Resources and Monash University Archives staff. HR Documents inherit their access control settings by default from the file they are placed on.
Where files are to be restricted the restrictions will be set by Lucy Taranto or Lin Jerrard when the file is created.

Where the security on a file or document needs to be changed the following HR staff members have the access rights to make the changes:

- John Denier
- Samira Ezadi
- Lin Jerrard
- Tina Robotis
- Lucy Taranto
- Russell Wade

9.2.3 Legal Folders and Documents

By default, Legal Folders can be viewed by all Monash University staff. Legal Documents inherit their access control settings by default from the file they are placed on.

Where Legal Folders are to be restricted the restrictions will be set by Records and Archives Services or members of Security Group: LFLD when the file is created.

Where the security on a file or document needs to be changed, the change will be made by Records and Archives Services or members of Security Group: LFLD.

9.2.4 Student Files and Documents

By default, Student Files can be accessed only by Records and Archives Services and staff responsible for student administration. Student Documents inherit their access control settings, other than Modify Record Access, by default from the file they are placed on.

Student Files are created by Records and Archives Services staff using information from Callista.

Staff who have access to Student Files are members of one of the following TRIM Groups:

**Security Group: Student Records – View**
Staff in this Group can view Student Files and Student Documents and add notes.

**Security Group: Student Records – Create**
The members of this group are a subset of Security Group: Student Records – View. Staff in this Group can:

- Register electronic Student Documents.
- Update the details of Student Files and Documents e.g. change their titles.
- Change the access settings for Student Documents.

Certain documents within a Student File will need to have their access restricted e.g. Academic Progress, Grievance and Special Consideration
documents. All access controls for these documents except for Update Document and Destroy Record should be changed.
10 Moving Records

10.1 Changing the Assignee

A file movement in TRIM is undertaken by changing its Assignee. The Assignee indicates at any time where a file or other record is located. Sometimes the file assignee will show as At Home which indicates the file is in storage, and the storage location will be shown.

Where the Assignee of a file is Records Storage: Electronic there is no physical file.

You may request a file from Records and Archives Services and the Assignee will be updated with your details.

Where you pass a file to someone else, you should change the Assignee in TRIM. If someone passes a file to you, check the Assignee to ensure it accurately shows who has the file.

**Tip:** Files assigned to you will appear in your In-Tray on the Trays shortcut.

To change the Assignee:
1. Locate the file or files.
2. Click the Set Assignee toolbar icon.
   - If moving multiple files to the same location tag each file and click the OK button at the prompt Apply To All Tagged Rows.
3. The Set Assignee dialog box will appear:

![Figure 47 - Set Assignee](image)

4. Delete the name or location currently displayed in Set to Location.
5. Type the last name (or start of the name) into the field and click the KwikSelect button.
6. Select the appropriate name from the list that is returned.
7. Click the OK button to save the change.
8. If moving multiple files, you will be asked to confirm the action Set Assignee – All Tagged Records. Select Yes to All.
11 Printing Reports

11.1 Print Report

The Print Report function allows you to print search results using a specified report layout (template).

When choosing the Print Report option TRIM will display a list of reports relevant to the items being printed. That is, different reports will be displayed when printing Records, Locations or Classifications.

The TRIM System Administrator can design and/or edit report layouts. TRIM reports are comprised of metadata information from the database, relevant to the TRIM item type that has been selected.

Most reports are printed from a search result window in TRIM although you may also print a report from favourites e.g. Trays or Favourite Records.

TRIM reports can be printed for a single selected record, or a list of tagged records, by clicking on the Print Report toolbar icon.

To print a report:

1. Select the record/s.
2. Highlight an entry or tag multiple entries.
3. Choose the Print Report toolbar icon.
4. If you have tagged more than one record for your report, the following dialog box will appear:

![Print Report dialog box](image)

*Figure 48 - Print Report - Apply To dialog box*

5. Choose the OK button and a list of reports will be displayed:
6. Highlight the appropriate report.
7. Select the Print button to print the report.

The following printing options are available:

- **Printing To**
  Use the drop-down to select the network or local printer from which the report will be printed.

- **Optional Title**
  Some reports allow you to enter a title. This title can be used to clearly indicate what the report is about. If required, enter the Title in this field.

- **Available Reports**
  This lists the report layouts that are available for printing. Select the appropriate report from the list.

- **Labels to Skip**
  This option is only available if printing labels. It gives you the ability to force the print to start at a certain point on the label sheet if you have already used some of the labels on the sheet.

- **Use Manual Feed**
  Select this option if you wish to use the manual feed tray on your printer.

- **Print**
  The Print button will print the report.

- **Preview**
  The Preview button will allow you to preview the report prior to printing.

- **Setup**
  The Setup button will open Window’s Print Setup dialog box. This dialog box allows you to modify the paper size, printer, orientation and the printer tray.
11.2 Print Merge

The Print Merge function allows you to save record metadata (record number, title, author etc.) in Microsoft Word, WordPerfect or Text (Tab Delimited) format. Print Merge can be used whenever information in TRIM needs to be made available to another application e.g. Microsoft Excel.

To send information to a Print Merge file:

1. Find your record/s.
2. Highlight an entry or tag multiple entries.
3. Right-click and choose Send To > Print Merge.
4. If you have tagged more that one record, the following dialog box will appear:

![Figure 50 - Send To Merge File - Apply To dialog box](image)

5. Choose the OK button and the Send To Merge File dialog box will appear:

![Figure 51 - Send To Merge File dialog box](image)

6. Tag fields in the Record Additional Fields list and/or Contacts, if required.

7. Tag the fields in the Record Properties list that you want to include in your Merge File e.g. record number, title, author.
Tip: Fields are not listed in alphabetical order so hit the key for the
first letter of the field you want to find to move through all fields
starting with that letter.

A + (plus) sign next to a field indicates that the field has
attributes that can be included in the merge file e.g. the email
address of an author

8. Select an option from the Output Format dropdown list.

Note: Select Tab Delimited if the application you intend to use is not
Microsoft Word or Word Perfect.

9. Use the Kwikselect on the Output Filename field to choose a path and
enter the filename for the merge file.

Note: Do not include the extension in your filename as TRIM will add
the appropriate extension i.e. .doc or .txt

10. If relevant select one or both of the merge file options:
    a. Append to Existing File – this will add the current entries
to a previously created file
    b. Merge an Entry for Every Contact – where the Contact
field is to be included in the merge file an entry will be
created for all contacts associated with a record e.g.
author and addressee

11. Click the OK button to create the Merge File.

12. To use the merge file either right-click on it, select Open With and select
the appropriate application or access it directly from the relevant
application.

Tip: TRIM will remember the fields that you tagged for a previous print
merge. To remove all tags right-click in the Include Tagged
Items list and select Untag All.